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General InformationSection 1:  

Introduction
Trace.Net is a Windows®-based application designed to view, analyze, edit, and print trace files saved 
with Noyes Mini & Handheld OTDRs.

Note: Trace.Net is not licensed software; you are free to copy it as needed. Please check our web 
site at www.AFLtele.com (click on Software) for software updates and additional application 
information.

This User’s guide contains detailed information about Trace.Net tools and commands and assumes 
you have a working knowledge of your computer and standard Windows menus & commands. For 
help with any of these techniques, please see your Windows documentation.

If you have any questions about your Noyes OTDR and Trace.Net software, or if you need technical or 
sales support, please contact Noyes Customer Service.

Contacting Noyes Customer Service
You may contact Noyes Customer Service between 8 a.m. and 5 p.m., United States Eastern Time, 
as follows:

Phone:	 800-321-5298 (North America) • 603-528-7780

Fax:	 603-528-2025

Web:	 www.AFLtele.com (click on Products > Noyes Test & Inspection)

E-mail:	 NOYTechSupport@afltele.com

http://www.afltele.com/resource%20center/software/index.html
http://www.afltele.com
http://www.afltele.com/products/test_inspection/index.html
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System Requirements
To use Trace.Net application, you need the following hardware and software:

A PC with a 1GHz (or faster) processor and an 800 x 600 (or larger) display•	

A CD or DVD drive if installing from CD•	

At least 256 megabytes (MB) of RAM•	

A Windows® compatible pointing device (mouse, trackball, etc.)•	

MS Windows® 2000, XP or Vista•	

Installing Trace.Net
You can install Trace.Net from the supplied CD-ROM, or you can download it from our web site at 
www.AFLtele.com (click on Software).

Follow the steps below to install the Trace.Net software.

To install from the application CD-ROM:

Start Windows. If Windows is running, quit all applications.1.	

Insert the Trace.Net CD into the CD-ROM drive. (Note: normally the D: drive.)2.	

The Installer will display the [Welcome] screen.3.	

Note: If the Installer does not start automatically, from Windows do one of the following: Note:   

Click on the [Start] button and select the [Run] command from the pop-up menu.•	

The [Run] dialog box appears. On the [Open] command line, type [D:\setup.exe].•	

http://www.afltele.com/resource%20center/software/index.html
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Click on the [OK] button to start.•	

	 OR

Double-click the My Computer icon on the desktop to open the My computer folder.•	

Double-click the CD-ROM icon.•	

Double-click [Setup] or [Setup.exe]•	

When the Installer [Welcome] screen is displayed, click on the [Next] button to continue.4.	

Follow the on-screen instructions.5.	

When the Installer displays the [Complete] screen, click on the [Finish] button.6.	

To download from the web:

From the www.AFLtele.com web site, select the following:  1.	

	 Software > Trace.Net Software > click on the download link.

Follow the on-screen instructions. The software will download to your computer’s hard drive. 2.	

Once downloaded, double-click on the [Trace_Net] or [Trace_Net.exe] file.3.	

When the Installer [Welcome] screen is displayed, click on the [Next] button to continue.4.	

Follow the on-screen instructions.5.	

When the Installer displays the [Complete] screen, click on the [Finish] button.6.	
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Starting Trace.Net
Follow the steps below to start the Trace.Net application: 

In Windows, click on the [Start] button.1.	

From the [Start] pop-up menu, select the [Programs] menu.2.	

Locate the Noyes Test & Inspection folder.3.	

Click on the Trace.Net shortcut.4.	

	 If you have installed the Trace.Net application in a folder other than Noyes Test & Inspection, 
choose that folder from the Start > Programs menu.

To see filename extensions that show fiber type and wavelength (m85, m13, s13, s15)  Note:   
when browsing for trace files, perform the following steps:

From Windows (not Trace.Net), open the folder containing trace files.5.	

Open the [View] dialog box by clicking on Tools > Folder Options > View.6.	

In the [Advanced Settings] window, remove the check next to the [Hide file extensions for 7.	
known file types] option.

Repeat steps 1- 3 for other folders containing trace files.8.	
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Trace.Net Screens and MenusSection 2:  
This section provides an overview of key features of the Trace.Net software.

Main Screen
The Trace.Net main screen is divided into several sections. Each section contains a specific type of 
information (refer to Figure 2-1). The table below gives a summary of the [Main] screen features.

Ref # Feature Description

1 Menu bar Displays the available pull down menus.

2 Toolbar
Contains several icons for quick access to menu commands.
Click on an icon to execute the associated command.

3 Zoom window Shows the current trace view relative to the entire trace.

4
Cursor 
measurement

This section displays the following information: A and B cursor 
locations, distance from A to B, selected loss method, plus (depending 
on the selected loss method) insertion loss, and reflectance.

5 OTDR/Text data
This section displays OTDR setup parameters or Text data when the 
corresponding tab [Trace info] or [Text info] is selected.

6 [Trace Info] tab
Click on this tab to display OTDR setup parameters stored in the 
selected trace file.



6
Trace.Net Main Screen.Figure 2-1:  
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7 [Text Info] tab
Click on this tab to display text information stored in the selected trace 
file.

8
[Edit Trace Info] 
button

Click on this button to display the [Edit Trace Information] screen, 
which allows editing of the Trace & Text info for the selected trace file.

9 Vertical split bar

This bar allows resizing of the [Trace graph] and [Event table] window 
vertically. 
Drag the Vertical bar to the left or right to decrease or increase the 
[Trace graph] and [Event table] window.

10
Horizontal split 
bar

This bar allows resizing of the [Trace graph] and [Event table] window 
horizontally.
Drag the Horizontal bar up or down to increase or decrease the [Trace 
graph] and [Event table] window.

11
[Event table] 
window

Displays saved events in a table format.

12
[Trace graph] 
window

Shows a graph of the currently selected trace. Up to four traces (dual 
trace with dual baseline) can be displayed in the [Trace graph] window.

13

Tab of the 
currently 
selected trace 
file

If several trace files are opened, click the desired trace tab to display 
the corresponding trace graph.
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Menu Bar
The Menu Bar located at the top of the Trace.Net Main Screen 
(see Figure 2-1) displays the available pull down menus. Each 
menu contains various commands. When a menu is selected, 
it displays a list of commands indicating a task associated with 
each command.

File Menu

The File pull down menu contains all the commands you need 
to open, save, print, edit, and close trace files. The table below 
gives a summary of the available File Menu commands and their 
associated functions.

Command Function

Open Trace� Ctrl+O

Depending on the selected option 
(Single-wavelength or Dual-
wavelength), open a single trace file 
or a trace file pair.

Open Baseline� Ctrl+B

Depending on the selected option 
(Single-wavelength or Dual-
wavelength), open a single trace file 
or a trace file pair as a baseline.
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Command Function

Next File� Ctrl+N Open the next (alphanumerical) file or pair in the current folder.

Previous File� Ctrl+P Open the previous (alphanumerical) file or pair in the current folder.

Save� Ctrl+S Save a trace file that already exists with its original name. 

Save As...
Save an existing trace file under a new name and preserve the 
original file.

Close
Depending on the selected option for closing files, close selected 
files after automatically saving changes, or prompt the user to 
confirm saving.

Close All Close all open trace & baseline files.

Print Print the currently displayed trace. 

Print Preview Preview an OTDR Trace Report before printing.

Batch Print Allows printing of all or selected trace files in the current folder.

Edit Trace Allows editing of trace text information and certain setup parameters.

Batch Edit Use to edit text or set up field(s) in one or more trace pairs.

M200 Trace File Transfer Allows transferring files from/to M200 OTDR.

OFL200 Trace File Transfer Allows transferring files from OFL200 OTDR.

Exit Close opened trace files and exit Trace.Net.
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Events Menu

The Events pull down menu contains all the commands you will need to select loss methods, add new 
events, and review or delete saved events.
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The table below gives a summary of the available Events menu commands and associated 
functions.

Command Function

Add Event� Ctrl+A
Add an event using the selected Loss Method at the active 
cursor location.

Loss Method�  Used to select the desired Loss Measurement Method.

Current Event:

	 •  Edit Comment 

	 •  Delete

Open a dialog box for adding and/or editing comments for 
the current event. The maximum comment length is 94 
characters.

Delete the current event.

Next Event Display the next event.

Previous Event Display the previous event.

Delete All Events� Shift+Del Delete all saved events in the selected trace.

Restore Event� Shift+Ins Restore the last event that was deleted.

Auto Events Generate an event table.

Restore LSA Defaults Restore LSA line lengths to the default values.
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View Menu

The View pull down menu contains all the commands you will need to magnify or reduce the display 
of any area in the [Trace graph] window, switch the active cursor, turn the Toolbar text on/off, and set 
up options. The table below gives a summary of the available View menu commands and associated 
functions.

Command Function
Zoom in Horizontally� Alt+Right

Zoom out Horizontally� Alt+Left

Zoom In Vertically� Alt+Up

Zoom out Vertically� Alt+Down

Un-Zoom� F6

Re-Zoom � F7

Magnify or reduce the display 
of any area in the [Trace graph] 
window

A-B Cursor� F4 Switch the active cursor

View Toolbar Text Turn the Toolbar text on or off

Options�

Use to select the appearance 
of traces and how they are 
opened/closed/saved. Also, use 
this command to choose how to 
download Trace.net updates. 
See Figure 2-2 for details.
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Options Dialog Box.Figure 2-2:  
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and close files
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distance units
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changed files

Turn Information 
Screen On/Off

Color Options to display 
single-mode traces

Color Options to display 
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Number of recently open files to be 
displayed under [File] menu

Options to display grid lines 
in Trace Window
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Toolbar
Several of the most commonly used commands can be accessed from the Toolbar. Click on a toolbar 
icon to execute the corresponding command. 

 

Locate and open the desired 
trace file.

Save a trace file that already 
exists with its original name.

Print the displayed trace file.

Open the Edit Trace 
Information dialog box.

Open the previous file (trace 
file pair) in the current 
folder.

Open the next file (trace file 
pair) in the current folder.

Zoom in horizontally around 
the active cursor.

Zoom out horizontally 
around the active cursor.

Zoom in vertically from the 
trace level at the active 
cursor.

Zoom out vertically from 
the trace level at the active 
cursor.
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Display the trace view at 
100%.

Zoom to the previous zoom 
level around the active 
cursor.

Select the previous event.

Select the next event.

Switch the active cursor.
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Trace Graph Window

Trace Graph Window.Figure 2-3:  
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The [Trace graph] window displays OTDR test results in a graph format; up to four traces (a trace pair and 
a baseline pair) can be displayed. The major features of the [Trace graph] window are explained below.

# Feature Description

1 Trace [Tab]
Displays the name and color of the open trace file. If several trace files are opened, click 
the desired trace [Tab] to display the trace graph.

2 Vertical axis Shows Insertion loss in dB.

3 Horizontal axis Shows distance in user-selected units.

4 Trace This is a graph of insertion loss vs. distance.

5
Cursors 
A and B

Used to measure insertion loss, power level, reflectance, attenuation, and distance. To 
make a cursor active, click on the cursor line or label, or click on the Toolbar Cursor icon 
to toggle between A and B cursors.
To move the active cursor, position the mouse pointer on a cursor, then click-and-drag 
along the trace graph. Also, you may use the Left and Right keyboard arrow keys.

6 Cursor label
To move the active cursor, position the mouse pointer on a cursor or a cursor label, then 
click-and-drag along the trace graph.

7 Event mark
Indicates the location and the number of a saved event. Events are listed in numerical 
order.

8 LSA lines
Available for certain loss measurement methods. Used for calculating insertion loss, 
trace level, and attenuation. 

9
LSA line 
boundaries

Near and Far LSA line boundaries for each LSA line segment. Used to control length and 
position (relative to trace segment) of LSA line.
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Event Table Window
The [Event table] window allows you to view test data associated with the trace displayed in the [Trace 
graph] window. If several trace files are opened, click the desired trace [Tab] located on top of the 
[Trace graph] window to display the [Event table] of the desired trace. Using the [Events] menu, you 
may add or delete trace events and edit comments.

Event Table Window.Figure 2-4:  
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Features of the [Event table] window are explained below.

Ref # Feature Description

1
Overall data 
row

This row displays the summary trace data: number of saved events, link 
loss, link ORL, and link length.

2 Event number
This column displays the number of the saved event in numerical / 
position order.

3 Atten.(dB/km)

This column displays the lead-in fiber attenuation. The dB/km 
measurement is the slope of the fiber leading to the event 
Note:  When the length of the fiber being measured is insufficient, the 
dB/km measurement is displayed followed by an asterisk [*] symbol. An 
asterisk [*] symbol indicates, “Section is too short to ensure an accurate 
fiber attenuation (dB/ km) measurement.” The required minimum 
distance is dependent on wavelength: 1550 nm = 2630 m, 1310 nm = 
1470 m, 1300 nm = 960 m, and 850 nm = 185 m.

4 Loss (dB)
This column displays the Insertion loss in (dB) of the fiber segment 
before the event.

5 Source
This column indicates how the event is added:
• manually - added by operator
• automatically - event table is generated by OTDR software

6 Type This column indicates the event type based on the selected loss method.
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7 Location
This column displays the distance from the OTDR or the end of the 
launch cable to the event.

8 Refl. (dB) Displays the Reflectance in (dB) for each reflective event

9 Loss (dB) Displays the Insertion loss in (dB) for each event.

Keyboard Shortcuts
Available Trace.Net keyboard shortcuts:

Open Trace... Ctrl+O

Open Baseline... Ctrl+B

Next File Ctrl+N

Prev File Ctrl+P

Save Ctrl+S

Add Event Ctrl+A

Delete All Events Shift+Del

Restore Event Shift+Ins

Move Active Cursor Left / Right Arrows

Zoom in Horizontally Alt+Right

Zoom out Horizontally Alt+Left

Zoom in Vertically Alt+Up

Zoom out Vertically Alt+Down

Un-Zoom F6

Re-Zoom F7

A-B Cursor F4
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Transferring Trace Files to a PCSection 3:  

Traces Saved with M200 OTDR
Trace files saved with an M200 OTDR are transferred to a PC using a USB cable. To transfer files from 
your M200 to a PC using a USB cable, perform the following:

Connect your M200 to a PC using a type A to Mini USB B cable. Make sure the mini-plug is 1.	
fully seated in your M200.

On your PC, open the Trace.net software. 2.	

From the Trace.net File menu, select [M200 Trace File Transfer] to open the [M200 Trace 3.	
Transfer] window (see Figure 3-1).

Select source Drive > Folder, and then select traces as required.4.	

	 For multiple trace selection, perform the following:

Click on the first trace to be added to highlight it.•	

Hold the Shift key to scroll down to the last trace you wish to select, and then click on it.•	

Select destination Drive > Folder.5.	

‘Drag and drop’ files into the destination folder. 6.	
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M200 Trace File TransferFigure 3-1:  
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Traces Saved with M600 or M100 OTDR
Trace files saved with M600 or M100 OTDR are transferred to a PC using the supplied ImageMate™ 
USB 2.0 Reader/Writer and CompactFlash™ memory card.

Transferring Traces

To transfer trace files to a PC perform the following steps.

Connect the supplied ImageMate USB Reader/Writer to a USB 2.0 port on your PC while 1.	
Windows® is running.

Windows will automatically recognize the ImageMate Reader/Writer and display it as 2.	
[Removable Disk] in the [My Computer] folder.

Insert the CompactFlash card with saved test data in the ImageMate Reader/Writer.3.	

Double-click on the [Removable Disk] icon to display saved trace files.4.	

Using Windows commands, copy the desired trace files to your PC.5.	

Important:  To avoid data loss or malfunctions of your computer or ImageMate Reader/Writer, it is 
important to use Windows [Eject] and [Unplug] commands before physically removing CompactFlash™ 
memory card and ImageMate Reader/Writer. Refer to the following sections for details.

Removing CompactFlash™ Memory Card 

Perform the following steps before removing a CompactFlash™ memory card from the ImageMate 
Reader/Writer:

Double-click on the [My Computer] icon to open the [My Computer] folder.1.	
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Right click on the [Removable Disk] icon.2.	

From the pop-up menu, select the [Eject] command.3.	

Pull the CompactFlash memory card out of the ImageMate USB Reader/Writer.4.	

Disconnecting ImageMate USB Reader/Writer

You don’t need to shut down your computer to disconnect the ImageMate USB Reader/ Writer, but 
you should never remove the device from the USB port without first reading the steps below. If a drive 
window is open, or the ImageMate Reader/ Writer is active, close any associated windows before 
attempting to remove the Reader/ Writer.

Use the [Add/Remove Hardware] command in Control Panel or [Safe to Remove Hardware] hotplug 
icon in the notification area of the taskbar to safely remove the ImageMate Reader/ Writer before 
unplugging. The notification area is on the right side of the taskbar where you usually see the current 
time displayed.

In the notification area, left click the Safely Remove Hardware icon - 1.	  .

Then left click the [Safely Remove Device...] message.2.	

When Windows notifies you that it is safe to do so, unplug the Reader/ Writer from your 3.	
computer.
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Traces Saved with OFL 250 OTDR
Trace files saved with an OFL 250 OTDR are transferred to a PC using a USB cable.

To transfer files, perform the following:

Connect your OFL 250 to a PC using a1.	  type A to Mini USB B cable. Make sure the mini-plug is 
fully seated in your OFL 250.

Press the [USB] soft key on the OFL 250.2.	

On your PC, open My Computer. A new removable drive named [OFL] should appear under My 3.	
Computer.

Copy the [Results] folder to your PC.4.	

Note:

Before removing the USB cable connecting your OFL 250 to your PC, or pressing the [Cancel] soft 

key on the USB page, left click the Safely Remove Hardware icon -  in the Start bar of your PC, 

then left click the [Safely Remove USB Mass Storage Device – Drive (?:)] message, where ‘?’ is the 
drive letter assigned to your OFL 250.
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Traces Saved with OFL 200 OTDR
Trace files saved with an OFL 200 OTDR are transferred to a PC using the Trace.Net software. File 
selection and transfer are done via the [Transfer Files from OFL 200] dialog box, which is accessed 
from the Trace.Net [File] menu.

OFL 200 File Transfer Dialog Box

The [Transfer Files from OFL 200] dialog box allows you to perform the following tasks:

Select all or multiple trace files for transferring to a PC.•	

Remove all or multiple trace files from the transfer list.•	

Rename trace files to be transferred.•	

Renumber trace files to be transferred.•	

Add information required for traces identification•	

The table below and Figure 3-1 describe the [Transfer Files to OFL 200] dialog box features.

Ref Feature Description

1
[Files on OFL 200] 
window

Displays a list of trace files saved with an OFL 200 OTDR.

Note:  If trace files are not displayed, select the appropriate 
Serial Port, and then click on the [Retry] button.

2 [Port] pull down list
Click on the [Down arrow] button to select the appropriate 
Serial Port.
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OFL 200 File Transfer Dialog Box.Figure 3-2:  
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3 [Retry] button
After the appropriate Serial Port is selected, click on this button 
to display a list of trace files in the [Files on OFL 200] window.

4 [File Destination] field
This field displays the destination folder on your PC. If needed, 
you may change destination by clicking [Edit].

5 [Select All] button

Allows selecting all trace files displayed in the [Files on OFL 
200] window.
Note: To select or deselect files individually, click on the check 
box of the desired file.

6 [Select None] button Allows deselecting all files.

7

[File Name]
[New Fiber Starting 
Number
[[Cable ID] 
[Tested By] 
[Test Site]
[Far Site]
[Comment]

Check these boxes and use the corresponding text editable 
fields, if you need to perform the following: 

Rename trace files to be transferred.•	

Renumber trace files to be transferred.•	

Add information required for traces identification•	

8 [Transfer Files] button Click on this button to start transferring.

9 [Exit] button
Click on this button to close the [Transfer Files to OFL 200] 
dialog box.
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Transferring Traces

To transfer trace files from the OFL 200 OTDR to your PC:

Turn the OFL 200 OTDR on.1.	

Connect the OFL 200 to your PC using the supplied serial cable.2.	

You should see the [Remote] soft key label on the OFL 200 display. Press the [Remote] soft 3.	
key on the OFL 200.

Open the Trace.Net software.4.	

From the Trace.Net [File] menu, select the [OFL 200 Trace File Transfer] command to display 5.	
the [Transfer Files From OFL 200] dialog box (see Figure 3-1). 

From the displayed list, select the files to be transferred. Refer to the section titled “OFL 2006.	  
File Transfer Dialog Box” for details.

Click on the [Transfer Files] button to start.7.	

While transfer is in progress, you will see a transfer progress bar.8.	

If needed, you may stop transferring at any time by clicking on the [Cancel] button.•	

When done, click on the [Exit] button.9.	



30

Managing Trace FilesSection 4:  

Single Trace or Trace Pair
Trace.Net offers two options for opening and closing trace files. Depending on the selected option, a 
trace file or trace files in wavelength pairs (dual-wavelength trace file pair) may be opened and closed 
within the current folder.

If the Single-wavelength option is enabled, then trace files will be opened and closed one-at-a-time. If 
the Dual-wavelength option is enabled, then trace files will be opened and closed in wavelength pairs 
(files with the same name, fiber number, and fiber type but different wavelengths).

For example:

If a folder contains files named “fiber_001_M85.sor” (multimode, 850 nm) and “fiber-001_M13.
sor” (multimode, 1300 nm)”, and in the file open dialog box the “fiber_001_M85.sor” file is selected 
for opening, then Trace.Net will automatically open both files. It doesn’t matter which file in a pair is 
selected first.

In addition to the current trace or pair, Trace.Net allows you to open a baseline trace or pair for 
comparison with the current trace. If a dual trace pair and a dual baseline trace pair are opened, a 
total of four traces can be displayed at one time.



31

Opening Trace Files

Opening a Single Trace

From the [View] pull down menu, select the [Options] command to display the [Options] dialog 1.	
box.

Select the [Single-wavelength] option, and then click on the [OK] button. 2.	

There are two ways to open a single trace file:3.	

From the [File] pull down menu, select the [Open Trace] command•	

	 or

Click the [Open] icon on the Toolbar•	

When the [Open Trace] window is displayed, locate the drive and directory containing trace 4.	
files.

From the displayed list of files, select the trace file you want to open.5.	

Click on the [Open] button to open the file.6.	

Select to open a single trace file
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Opening a Trace Pair

From the [View] pull down menu, select the [Options] command to display the [Options] dialog 1.	
box.

	Select the [Dual-wavelength] option, and then click on the [OK] button. 2.	

There are two ways to open a trace pair:3.	

From the [File] pull down menu, select the [Open Trace] command•	

	 or

Click the [Open] icon on the Toolbar•	

When the [Open Trace] window is displayed, locate the drive and directory containing trace 4.	
files.

From the displayed list of files, select the trace file you want to open.5.	

Click on the [Open] button to open the file.6.	

Select to open trace files in 
wavelength pairs



33

Opening Previous or Next Traces

After you open a single trace or trace pair, you may use the [Prev File] and [Next File] commands 
to display the previous or next trace or trace pair of the same fiber type (MM or SM) in the current 
folder.

There are three ways to display the previous or following trace or trace pair:

From the [File] pull down menu, select the [Next File] or [Previous File] command.•	

Click the [Next File] or [Prev File] icon on the Toolbar.•	

Use the shortcuts: [Ctrl+N] - next trace; [Ctrl+P] - previous trace.•	

Comparing Traces with a Baseline Trace
Trace.Net allows you to open a baseline trace or trace pair for comparison to another trace or trace 
pair. If a dual baseline trace pair and a dual trace pair are opened, a total of four traces can be 
displayed at one time.

From the [View] pull down menu, select the [Options] command to display the [Options] dialog 1.	
box. From this dialog box, select Single-wavelength (or Dual-wavelength) option, and then 
choose [OK]. 

From the [File] pull down menu, select the [Open Baseline] command.2.	

When the [Open Baseline Trace] window is displayed, locate the drive and directory •	
containing trace files.

From the displayed list of files, select the trace file you want to open.•	
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Click on the [Open] button to open the file.•	

From the [File] pull down menu, select the [Open Trace] command.3.	

When the [Open Trace] window is displayed, locate the drive and directory containing trace •	
files.

From the displayed list of files, select the trace file you want to open.•	

Click on the [Open] button to open the file.•	
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Closing Files with Changes
Two options are available for closing trace files with changes: [Save Automatically] and [Ask “Would 
you like to save changes?”].

[Save Automatically] option [Ask “Would you Like to save changes?”] 
option

If a trace file has been edited and not 
saved, it will be saved automatically 
before closing.

If a trace file has been edited and not saved, a dialog 
box will appear prompting you to save changes before 
closing. 

To specify how trace files will be closed perform the following steps.

From the [View] pull down menu, select the [Options] command to display the [Options] dialog 1.	
box.

Select the desired option, then click on the [OK] button.2.	
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Analyzing TracesSection 5:  

Moving Cursors and Zooming
The [A] and [B] cursors may be positioned to measure the insertion loss, power level (if applicable), 
reflectance (if applicable), attenuation (if applicable), and distance between any two points on a 
trace.

To make cursor positioning easier, Trace.Net provides tools and commands for viewing different parts 
of a trace graph at various magnifications. [Zoom In] and [Zoom Out] commands let you magnify or 
reduce the display of any area in the [Trace graph] window.

Trace.Net zooms horizontally around the active cursor and vertically from the trace level at the active 
cursor.

Selecting the Active Cursor

To make a cursor active, do one of the following:

In the [Trace graph] window, click on the desired cursor line or label.•	

From the Toolbar, click on the [Cursor] button  •	   to toggle between cursors.

From the [View] pull down menu, select the [A-B Cursor] command to toggle between cursors.•	

Press the [F4] key on your keyboard to toggle between cursors.•	

Once the active cursor is selected, it can be moved along the trace graph.
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Moving the Active Cursor

To move the active cursor, do one of the following:

Position the mouse pointer on a cursor line or cursor label, then click-and-drag along the trace •	
graph.

Use the [Left] and [Right] keyboard arrow keys.•	

The [A] cursor cannot be moved beyond the [B] cursor location, and vice versa. Note:   

Click on an event in the event table, the active cursor will jump to that event on the trace graph.•	

Zoom In and Out of a Trace

You can magnify or reduce the trace display performing one of the following:

From the Toolbar, click on the corresponding Zoom button.•	

Zoom in horizontally around the active cursor.

Zoom out horizontally around the active cursor.

Zoom in vertically from the trace level at the active cursor.

Zoom out vertically from the trace level at the active cursor.

Each click magnifies the view to the next preset percentage until the limit of magnification  Note:   
is reached.
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From the Menu bar, select the [View] pull down menu, and then choose the desired Zoom •	
command.

	

Un-zoom and Re-zoom the Trace Display

In the zoomed view, Trace.Net always displays the active cursor area. The [Un-zoom] and [Re-zoom] 
commands allow you to display different areas of a trace graph at the same level of magnification. If 
you need to view a different point of the trace, move the active cursor, un-zoom and then re-zoom. 
Trace.Net will display the new position of the active cursor at the previous zoom level.

Perform the following steps:

In the [Trace graph] window, use the [Zoom In] and [Zoom Out] commands to set the desired 1.	
level of magnification.

Click on the [Un-zoom] button to display the trace view at 100%.2.	

Relocate the active cursor as needed (or toggle between A and B cursors).3.	

Click on the [Re-zoom] button to display the new cursor location at the previous zoom level.4.	

When you toggle between [A] and [B] cursors in the magnified view, the view changes to  Note:   
display area around the selected cursor at the same magnification level.
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Selecting Loss Method
For analyzing traces and adding events, Trace.Net offers various Loss methods. The following table 
gives a summary of the available methods.

Loss Method (and applications) Measured parameters
# of 
cursors 

# of LSA 
lines*

Two Point (general purpose)
Insertion loss between any 2 
points of a trace

2 0

Single Event (used to analyze connections, 
splices, faults, etc.)

Location, Reflectance, Insertion 
loss of any Reflective or Non-
Reflective event

1 2

Multiple Event (used if two or more events 
are too close to use other methods)

Location and combined Insertion 
loss of multiple events

2 2

Fiber Attenuation (used to measure dB/km 
of fiber between events)

Attenuation per km ratio of any 
segment of a trace with no events

2 0

Start - No Launch Cable (used to set start 
of fiber level)

Starting location and level of a 
trace

1 1

End - No Receive Cable (Used to set end 
of fiber level)

Location, Reflectance, and Trace 
level of the fiber end

1 1

* LSA Line - least squared approximation segment line. Used to reduce the effects of noise and dead 
zone while calculating insertion loss, trace level, and attenuation.
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To select the desired Loss method perform the following: 

From the Menu bar, choose the [Events] pull down menu.1.	

Choose the [Loss Method] command to display a list of the available options.2.	

Select the desired Loss method.3.	

Positioning Cursors Correctly 
Depending on the selected Loss Method, you will need to position cursors and adjust LSA lines (if 
applicable) properly. The following graphs illustrate position of cursors and LSA lines for the available 
Loss methods.

Two Point Loss Method

Position the left cursor at the start 4.	
of the event.

Position the right cursor beyond 5.	
the event where the trace returns 
to a constant slope.

Read the insertion loss 6.	
measurement displayed in the 
[Cursor measurement] window.

Left cursor Right cursor
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Single Event Loss Method

Position a cursor at the start of the event.

If required, adjust the right LSA line so the Near Right boundary is located beyond the event 1.	
where the trace returns to a constant slope.

Read the insertion loss measurement displayed in the [Cursor measurement] window.2.	

	 or

From the [Events] pull down menu, choose the [Add Event] command to save.3.	

Left LSA line Right LSA line

Cursor Near Right boundary
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Multiple Event Loss Method

Position the left cursor at the start of the first event.1.	

Position the right cursor at the start of the last event.2.	

If required, adjust the right LSA line so the Near Right boundary is located beyond the event 3.	
where the trace returns to a constant slope.

Read the insertion loss measurement displayed in the [Cursor measurement] window.4.	

	 or

From the [Events] pull down menu, choose the [Add Event] command to save.5.	

Left LSA line Right LSA line

Near Right boundary

Right cursor
Left cursor
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Fiber Attenuation Loss Method

This method is used just for analyzing a trace.

Position left and right cursors on the trace as needed.1.	

Read the insertion loss (dB/km) measurement displayed in the [Cursor measurement] window.2.	

Left cursor Right cursor
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Start (No Launch Cable) Loss Method

Position the left cursor at the beginning of the trace (0 meters).

If required, adjust the right LSA line so the Near Right boundary is located beyond the reflection 1.	
where the trace returns to a constant slope.

Read the trace level measurement displayed in the [Cursor measurement] window.2.	

	 or

From the [Events] pull down menu, choose the [Add Event] command to save.3.	

Cursor at the origin

Near Right boundary

Right LSA line



45

End (No Receive Cable) Loss Method

Position the Left cursor at the start of the Far-end reflection.1.	

If required, adjust the left LSA line.2.	

Read the trace level measurement displayed in the [Cursor measurement] window.3.	

	 or

From the [Events] pull down menu, choose the [Add Event] command to save.4.	

Left LSA line

Left Cursor
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Adjusting LSA Lines
If events of a trace are located very close to each other, you may have to adjust the LSA Lines. The 
graphs below illustrate an example of the right LSA line before and after the adjustment.

To adjust LSA lines, position the mouse pointer over an LSA line boundary, then click and drag to the 
desired location.

Note:  if you need to restore the original LSA lines lengths values, choose the [Restore LSA Defaults] 
command from the [Events] pull down menu.

LSA Line before the adjustment

LSA boundary line

LSA Line after the adjustment
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Add Event Dialog Box.Figure 5-1:  

Adding Manual Events 
To add manual events, perform the following steps:

Select the desired Loss method.1.	

Event type displayed in the Event Table will match the currently selected loss method. Note:   

Move the active cursor to the event to be added.2.	

From the [Events] pull down menu, select the [Add Event] command.3.	

The [Add New Event] dialog box opens displaying the event data that will be added to the 4.	
[Event table] and allowing you to add a comment.

Comment text field� - this is the text field 
where you add comments if needed.

Event data� - this information will be added 
to the [Event table]
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Type a comment in the Comment text field (maximum 94 characters) if needed.5.	

Choose OK to save. Trace.Net automatically places an event mark in the [Trace graph] window 6.	
and event data in the [Event table] window.

Editing Comments
To edit a comment, do one of the following:

In the [Event Table], select the desired event by clicking on it.1.	

From the [Events] pull down menu, select the [Current Event] > [Edit Comment...] •	
command to display the [Edit Event] dialog box.

Edit comments as needed.•	

Click on the [OK] button to save changes.•	

	 or

In the [Event Table], select the desired event by clicking on it.1.	

Right-click the selected event, to display a submenu.2.	

From the displayed submenu, select the [Edit Event] command to display the [Edit Event] •	
dialog box.

Edit comments as needed.•	

Click on the [OK] button to save changes.•	
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Deleting Events
To delete an event, do one of the following:1.	

In the [Event table], select the desired event by clicking on it.2.	

From the [Events] pull down menu, select the [Current Event] > [Delete] command•	

	 or

In the [Event table], select the desired event by clicking on it.3.	

Right-click the selected event, to display a submenu.•	

From the displayed submenu, select the [Delete Event] command.•	
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Editing Trace Information

Editing a Single Trace

Trace.Net allows you to edit trace information and certain setup parameters. This is done in the [Edit 
Trace Information] dialog box.

There are three ways to display the [Edit Trace Information] dialog box.1.	

From the [File] pull down menu, select the [Edit Trace] command.•	

From the Toolbar, click on the [Info]  •	   button.

Click on the  •	   button.

When the [Edit Trace Information] dialog box is displayed, edit text fields as required.2.	

Choose [OK] to save changes.3.	

Refer to the following description and Figure 5-2 for details.4.	

Ref #
[Edit Trace Info.] 
dialog box feature

Description

1 [Text Info] section
This section contains text fields where you enter the 
information you need to identify a trace.

2 Date field
Click on the [Down arrow] button at the end of the Date field  
to display a pop-up calendar and edit test date as needed.

3 Fiber number field Allows you to change the fiber number.
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Edit Trace Information Dialog Box.Figure 5-2:  

4 Group index Allows you to change the Group index value.

5 BackScatter coefficient Allows you to change the BackScatter coefficient value.

6 Reflectance threshold Allows you to change the Reflectance threshold value.

1

4

3

5

2

6



52

Batch Editing

The Batch editing feature allows you to edit all or selected test properties (such as fiber name, fiber 
number, test site data, and comments) in multiple trace files in the current folder. This is done in the 
[Batch Editor] dialog box. The [Batch Editor] dialog box consists of several windows and control buttons. 
The table below gives a summary of the [Batch Editor] dialog box features (see Figure 5-3).

Ref # Feature Description
1 [Drive] window Allows you to navigate to the desired folder
2 [Files in Folder] window Displays all trace files in the currently selected folder
3 [Files to Edit] window Displays all trace files added to the batch edit list
4 [Add File] button Adds a single trace or multiple traces to the batch edit list
5 [Add All Files] button Allows you to add all traces in the folder to the batch edit list
6 [Remove File] button Allows you to remove a single trace or multiple traces from the 

batch edit list
7 [Remove All Files] button Allows you to remove all traces from the batch edit list
8 Properties check boxes Select corresponding check boxes to activate editable text fields
9 Text editable fields This section contains text fields where you enter all information 

you need to identify traces
10 [Clear All] button Removes all text from the text fields section
11 [Process Traces] button Click on this button to complete changes
12 [Exit] button Closes the [Batch Editor] dialog box
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Batch Edit Dialog Box.Figure 5-3:  
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To edit all or selected files, perform the following:

From the [File] pull down menu, select the [Batch Edit] command to access the [Batch Editor] 1.	
dialog box. 

In the [Folders/Files] window, locate and select the desired folder.2.	

Double-click on the selected folder to open it.3.	

All trace files in the open folder will be displayed.4.	

From the displayed list, add the desired traces to the ‘Files to Edit’ list, which will be displayed 5.	
in the [Files to Edit] window. Use the [Add File] or [Add All Files] buttons for adding trace files.

	 To add trace files in the current folder to the batch edit list individually:

Double-click the desired trace name listed in the [Folders/Files] window. The trace name •	
added to the batch edit list will appear in the [Files to Edit] window.

Or, click on the desired trace name listed in the [Folders/Files] window, then click on the •	
[Add File] button. The trace name added to the batch edit list will appear in the [Files to 
Edit] window.

	 To add a group of traces in the current folder to the batch edit list:

Click on the first trace to be added to highlight it.•	

Hold the Shift key to scroll down to the last trace you wish to add to the batch edit•	  list.

Click on the [Add File] button. The trace names of the selected files will appear in the [Files •	
to Edit] window.
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	 To add all trace files in the current folder to the batch edit list:

Click on the [Add All Files] button. The added trace names will appear in the [Files to Edit] •	
window.

If you need to remove trace files from the batch edit list displayed in the [Files to Edit] window, 6.	
use the[Remove File] or [Remove All] buttons.

	 To remove trace files from the batch edit list individually:

Double-click the desired trace name displayed in the [Files to Edit] window. The trace name •	
listed in the [Files to Edit] window will be removed.

Or, click on the desired trace name displayed in the [Files to Edit] window, then click on the •	
[Remove File] button. The trace name listed in the [Files to Edit] window will be removed.

	 To remove a group of traces from the batch edit list:

Click on the desired traces to be removed to highlight.•	

Click on the [Remove File] button. The trace names listed in the [Files to Edit] window will •	
be removed.	

	 To remove all trace files from the batch list:

Click on the [Remove All] button. All trace names listed in the [Files to Edit] window will be •	
removed.

To activate editable text fields, select corresponding check boxes.7.	

Edit text fields as needed.8.	

Choose [Process Traces] to complete changes.9.	
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Printing Trace ReportsSection 6:  

Printing a Single Trace Report
There are two ways to print a single trace currently displayed in the [Trace graph] window:

Click on the Toolbar Print  •	   icon. 

Or, from the [File] menu, select the [Print] command. The [Print] dialog box will be displayed •	
(see Figure 6-1).

The [Print] dialog box, allows you to select a 
printer and set up the printing options.

Click on the [Down arrow] button at 1.	
the end of the [Name] pull down list to 
display the available printers.

From the displayed list, select the 2.	
desired printer.

If you have a PDF printer installed,  Note:   
you may select it for producing trace 
reports (single trace or active trace 
of open pair of traces) in the PDF file 
format. 

Print Setup Dialog Box.Figure 6-1:  

2 4
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If needed, you may click on the [Properties] button to display the [Printing Preferences] dialog 3.	
box and change settings that affect the way documents are printed. 

When all settings are complete, click on the [OK] button to print a single trace report.4.	
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Printing Multiple Trace Reports - Batch Printing
For printing multiple trace reports, Trace.Net provides a Batch Print feature, which simplifies printing 
operations by allowing multiple trace files to be printed simultaneously. Using the [Batch Print] 
command, all trace files that require printing can be selected and processed at once. This is done in 
the [Batch Printing] dialog box.

Batch Print Dialog Box

The table below gives a summary of the [Batch Print] dialog box features (refer to Figure 6-2).

Ref # Feature Description
1 Directories window Allows you to navigate to the desired folder
2 [Folders / Files] window Displays folders / files in the currently selected folder
3 [Files to Print] window Displays all trace files added to the print list
4 [Trace Preview] window Allows you to view the selected trace graph
5 [Cover Page] check box Check this box if you prefer to print a cover page 

6
[Setup Cover Page] 
button

Allows you to access the [Cover Page Setup] dialog box and 
add necessary information to the cover page

7 [Add File] button Adds a single trace or multiple traces to the print list
8 [Add All] button Allows you to add all traces to the print list
9 [Remove File] button Removes a single trace or multiple traces from the print list
10 [Remove All] button Allows you to remove all traces from the print list
11 [Zoom] arrow buttons Allows you to set up a zoom level for all traces in the print list
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12 [Print Files] button Sends the created batch print job to a printer
13 [Exit] button Closes the [Batch Printing] dialog box

Batch Print Dialog Box.Figure 6-2:  
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Selecting Traces for Batch Print

From the [File] menu, select the [Batch Print] command to access the [Batch Print] dialog box 1.	
(refer to Figure 6-2).

Locate and select the desired folder.2.	

Double-click on the selected folder to open it.3.	

All trace files in the open folder will be displayed in the [Folders / Files] window.4.	

If you need to view a trace graph before adding a trace file to the print list, it is displayed in the 5.	
[Trace Preview] window. Click on the desired trace name listed in the [Folders / Files] window 
to display the selected trace graph in the [Trace Preview] window.

From the [Folders / Files] window, add the desired traces to the print list, which will be 6.	
displayed in the [Files to Print] window. Use the [Add File] or [Add All] buttons for adding trace 
files.

	 To add trace files in the current folder to the print list individually:

Double-click the desired trace name listed in the [Folders / Files] window. The trace name •	
added to the print list will appear in the [Files to Print] window.

Or, click on the desired trace name listed in the [Files in Folder] window, then click on the •	
[Add File] button. The trace name added to the print list will appear in the [Files to Print] 
window.

To add a group of trace files in the current folder to the print list:

Click on the first trace to be added to highlight it.•	
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Hold the Shift key to scroll down to the last trace you wish to add to the batch print•	  list.

Click on the [Add File] button. The trace names of the selected files will appear in the [Files •	
to Print] window.

	 To add all trace files in the current folder to the print list:

Click on the [Add All] button. The added trace names will appear in the  [Files to Print] •	
window.

You may set horizontal and vertical zoom level for all trace files in the current folder. The zoom 7.	
level you set for one trace applies to all traces in the current folder.

Use the [Zoom] arrow buttons to set horizontal and vertical zoom level.•	

If you need to remove trace files from the print list displayed in the [Files to Print] window, use 8.	
the [Remove File] or [Remove All] buttons.

	 To remove trace files from the print list individually:

Double-click the desired trace name displayed in the [Files to Print] window. The trace •	
name listed in the [Files to Print] window will be removed.

Or, click on the desired trace name displayed in the [Files to Print] window, then click •	
on the[Remove File] button. The trace name listed in the [Files to Print] window will be 
removed.

	 To remove all trace files from the print list displayed in the [Files to Print] window:

Click on the [Remove All] button. All trace names listed in the [Files to Print] window will be •	
removed.
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To create a Cover page for trace reports, click on the [Setup Cover Page] button (refer to the 9.	
section titled “Creating a Cover Page” for more information).

To print a Cover Page in addition to trace reports, verify that the [Include Cover Page] check 10.	
box is selected.

When all settings are complete, click on the [Print Files] button to send the batch print job to 11.	
a printer.
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Creating a Cover Page for your Batch Print Job

Trace.Net allows you to create a cover page for your Batch Print Report. To create a cover page, 
perform the following steps.

From the [File] menu, select the [Batch Print] command to access the [Batch Printing] dialog 1.	
box (refer to Figure 6-2).

To print a cover page in addition to trace reports, verify that the [Include Cover Page] check 2.	
box is selected.

Create a batch print list (refer to the section titled “Selecting Traces for Batch Printing”).3.	

Click on the [Setup Cover Page] button to access the [Cover Page Setup] dialog box.4.	

The [Cover Page Setup] dialog box contains several pages as follows:5.	

Preparer Information page
This page contains text 
fields where you enter 
Preparer company name and 
address.
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Company Information page
This page contains text 
fields where you enter 
Customer company name 
and address.

Project Information page
This page contains text 
fields where you enter all 
information you need to 
identify your project.

When you finish entering all the necessary information, click on the [OK] button to return to the 6.	
[Batch Printing] dialog box.



65

Thank you for choosing Noyes Test & Inspection

16 Eastgate Park Road 
Belmont, NH 03220  
Phone:	800-321-5298
	 603-528-7780
Fax:	 603-528-2025
www.AFLtele.com > Products > Noyes Test & Inspection
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